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1 Preface

This section provides information about the HCL IntelliOps Event Management (IEM) User Guide that

includes the following topics.
— Inten Audien
— About This Guide
— Related D ment

— Conventions

1.1 Intended Audience

This guide is intended for HCL IEM end-users like Command Centre, DC Ops teams etc. working towards

the resolution of actionable issues detected by HCL IEM by correlating alerts.

1.2 About This Guide

This guide will introduce users to the key concepts of HCL IEM and provide instructions on how they can
use this product to its full potential. It will provide an overview of the end-user interface and contains
instructions to perform different tasks.

This document includes the following topics:

— HCL IEM Overview

— System Requirements

— Using HCL IEM
- Support

1.3 Related Documents

The following documents can be referenced in addition to this guide for further information on the HCL

IEM platform.

— Introduction to HCL IEM User Guide

1.4 Conventions

The following typographic conventions are used in this document:
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Table 1 - Conventions

Convention

Element

Boldface

Indicates graphical user interface elements associated with an action, or terms

defined in text or the glossary

Underlined blue

Indicates a cross-reference and links

Courier New (Font)

Indicates commands within a paragraph, URLs, code in examples, and paths

including on screen text and text input from users

[talic

Indicates document titles, occasional emphasis, or glossary terms

Numbered lists

Indicates steps in a procedure to be followed in a sequence

Bulleted lists

Indicates a list of items that is not necessarily meant to be followed in a

sequence

IEM User Guide
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2

2.1

2.2

Introduction

This user guide is intended for HCL IEM end-users like Command Centre, DC Ops teams etc. that are

working towards the resolution of actionable issues detected by HCL IEM by correlating alerts.

Overview of IEM

HCL IntelliOps Event Management is an Al-powered IT event management platform on the cloud that
transforms IT operations by incorporating AlOps capabilities into the system. Its machine learning-based
advanced features, such as topology correlation, anomaly detection, and noise reduction, not only help
reduce Mean Time to Detect (MTTD) and Mean Time to Recover (MTTR) of incidents but also proactively
detect potential issues, prevent outages, and ensure service continuity for businesses.

This intelligent platform provides integrations with various monitoring tools and custom code within an
ecosystem to ingest a vast volume of heterogeneous data in the form of events, metrics, performance, and
configuration information. Its client-side component — IEM-(IMM) Integration Management Module
collects raw events from various monitoring systems and send it to IEM, it also offers a unique feature of
continuous service delivery in the case of connectivity loss with IEM Cloud, minimizing the impact of
outages on IT operations.

IEM also fosters efficient collaboration across teams, ultimately improving system performance and aqility.
Its integration with ITSM tools packages industry best practices, significantly reducing duplicate incidents
and enhancing the Root Cause Analysis process by automatically correlating incidents with Change

Management.

Key Features

— Early Anomaly Detection: Utilizes metrics for early identification of true anomalies in the lifecycle.
Metric anomaly system is available to identify anomalous metric point for outlier detection based on

metric data being ingested.

— Topology Based Alert Correlation: OOB correlation rules available for Correlation of alerts based on

relationships between entities defined in the system.

— Temporal-Based Alert Correlation: Leverages a robust correlation engine and condition-based
correlation for automatic grouping and mapping of alerts with and efficient Feedback System to avoid

irrelevant alert to actionable grouping.

— OOB NiFi Connector Management via IMM (Integration Management Module) Portal: Topology, Entity

and Service data ingestion via NiFi in real-time.

— Automated Noise Reduction: Filters out irrelevant data to reduce noise and focus on meaningful

events. There is Noise Rule Configuration with maintenance windows support.

— Related Problems and Changes view of Actionable for Effective Diagnosis: Helps in addressing impact

assessment for continuous improvement and prioritize actionable based on their potential impact.

IEM User Guide n



— Real-Time Interactive Visualization: Provides user-friendly dashboards for real-time interaction with
Metric View, Service View, and Topology View. Timeline view is also available for events, alerts, and

actionable.

— Quick User’s Collaboration: Enables quick chat and collaboration with the team for efficient
communication thereby reducing MTTR along with automated notifications to operators for assigned

actionable.

— Cost Saving View: Significantly benefits by optimizing resources, improving operational efficiency, and

reducing unnecessary expenditures on actionable resolution and reviving the degraded services.
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3 IEM Interface

The interface presents a unified views like Metric View, Topology View and Service View to facilitate Event
Management helping IT Professionals understand the relationships between different entities and services

to make informed decisions to manage and troubleshoot complex IT environments more efficiently.

3.1 Login to HCL IEM

HCL IEM can be accessed web browser, with the sole exception of Internet Explorer. After the user receives
their login credentials, they should perform the following steps to log into HCL IEM:

1. Launch web browser (Chrome, Mozilla, or Edge) and use the HCL |IEM Portal URL.

2. Onthe HCL IEM Login page, type your email ID registered with HCL IEM in the Email field and

password in password field.

HCL IntelliOps
Event Management

Please enter your Email ID

superadmin@hcl.com

Figure 1- Login

3. Post successful authentication, the user logs into the HCL IEM portal on home page.
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Events Bty Actionable Open Actionsble Impacted Services Approx. sawings in USDS)
1 1 1 1 0 0
=70y 4 w=7oy Lo 4 e 4 T ' L
Service Overview
| Lucy | MyCloud DR | Mycloud
0 o o 0 o o o o o
Passible Impacted Servce: Possibe Impacted Service: i Possible Impacted Service:
| ideploy
0 o o

Possible Impacted Service: Mycloud

Figure 2 - Home Page

The user interface is comprised of three views:

e Home

o Dataview

e Customer
The interface also presents unified views like Metric View, Topology View and Service View to provide a
visual representation of the relationship between services and entities in the system.
The Home Screen is a dashboard where a user can see three different views:

e Metric View

e Service View

o Topology View

3.1.1 Metric View

The Metric view shows the value for different metrics corresponding to Events, Alerts, Actionable for a

particular customer. It gives a view of open actionable and impacted services. In addition, Noise Reduction

percentage, calculated to date, is also shown in the metric view.

MezicView  Senee View  Tapology View

Metric Overview

Events Bty Actionable Open Actionsble Impacted Services

1 1 1 1 0

FapetEs b Lm7one 4 e 4 T
Service Overview

| Lucy | MyCloud DR | Mycloud

0 o o 0 o o o o o
Passible Impacted Servce: Possibe Impacted Service: i Possible Impacted Service:
| ideploy

0 o o

Passible Impacted Serwice: Mycloud

Figure 3 - Metric View
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3.1.2 Service View
Applications consist of multiple services running on different nodes or entities. These services are often
related to each other in a Parent-Child relationship where issue on a child service gets cascaded onto
parent service and further up in hierarchy. In a complex or large environment, analyzing this impact is very
challenging and leads to higher MTTR, RCA and outages. With HCL IEM Service View, Users can quickly

identify the Causal Service and corresponding Impacted Services enabling them to trigger appropriate

remediation process in minimal time.

Home

Metric View Service View Topology View

a
dryiceiem
.
Mycloud
Lucy ideploy

MyCloud DR

Figure 4 - Service Overview

3.1.3 Topology View

Topology View shows the relationship between entities for a particular customer. Parent and Child nodes

are depicted in the Topology view chart, as configured for the selected customer.

Home

Metric View Service View Topology View

Figure 5 - Topology View

3.2 Data View

The data view acts as the user’s visual guide into granular data related to the events, alerts, actionable and
noise data, in a single, unified view that permits the user to filter data according to their requirement and

obtain a more transparent view of the system and any issues related to the services configured within the

system.

Based on the configuration, five data views are displayed over this console.

IEM User Guide
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e Events

o Alerts

e Actionable
e All Events

e Noise Events

3.2 Events
An "event" refers to a significant occurrence or incident within an IT environment that is detected,
monitored, and logged by various systems and tools. Events are typically generated by hardware, software,
applications, or network devices, and they serve as a key source of information for monitoring and
managing the performance and health of IT systems.
Events can be diverse and may include activities such as system errors, warning messages, user
interactions, configuration changes, or security-related incidents.

This view will show all events that have come into HCL IEM system after removal of noise events.

Events are classified as noise if it satisfies the rule condition.

Please follow below steps to view events data:
1. Inthe top navigation bar, click on Data View and click on Events.

2. Events data will be displayed for the customer to which user is part of.

Data View > Events

Select Events View Events v U Live S B R

— s p N 7 \ 7 ~ 7 N
(Al J{_® Critical ) Major /: i Minor ) { Warning ) { Clear ) (_® Indeterminate )

Severity 1D Entity  Parameter Event Time Title Manager Primary Application Name ToolID  Secondary Application Name Agent

QUGRPHMIXT entity2 memory 2024/02/09 17:07:31 memary issue

Figure 6 - View Events

This option will enable user to add more columns in data grid to analyze it deeply. Please follow below
steps to add columns to data view.

1. In the top navigation bar, click on Data View and click on Events.

2. Click onthe Add Column action button present at right side of Live button.

3. A pop-up will open up which enables user to select from list of available columns to add it in the grid

as shown in figure. Then, click on save button to add selected columns in view.

IEM User Guide 16



Add Columns X

Add More Columns

Sub Entity ID v

Original Columns

~

T Severity X o Ip X T Entity X D Title X Z Manager X C Primary Application Name X Z ToollD X

Z Secondary Application Name X O Agent X O EventTime X T MappedEntity D X O Parameter Category X

~ ~ ~

O Parameter X O location X C Environment X O Designation X

Newly Added Columns

Z Sub Entity ID X

Save Close

Figure 7 - Add Column

3.2.1.3 Save As Events

This option will enable user to save currently opened view with columns populated in data grid so that
same view can be shown to any other user in an organization. It is very helpful for admins to configure this
kind of view for other users in an organization by creating a different view other than current view. For e.g.,
view to list out events with critical severity only. Please follow below steps to save as events:
1. Inthe top navigation bar, click on Data View and click on Events.
2. Once the user clicks the Save button, a pop-up will open to provide following information:
e View Name: name of view like critical events
e Description: description of view like list all critical events

e Show to: Either it will be visible to user who is saving it or to other users.

Save As X
View Name Description

Show to

My Self v

Figure 8 - Save as Events

IEM User Guide
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3.21.4 Refresh Events

This option will enable user to refresh data grid to populate latest data over screen.

Please follow below steps to refresh events grid:
1. Inthe top navigation bar, click on Data View and click on Events.

2. Once the user can click the Refresh button, confirmation pop up message will appear.

Data View > Events

Select Events View Events ~ l T X 2 Live S B R
v

) (o e (& v ) (& wanar) (& warming ) (3 o ) (@ termnate )

Severity 1D Entity  Parameter Event Time Title Manager  Primary Application Name Tool ID  Secondary Application Name Agent
= GUGRPHMSXT entiz  memory 2024/02/09 17:07:31 memory issue i i
) rosmcancom entiyd  swap 2024/02/08 17:07:31 swap issue i nif

[ msior | XIXT4TINGS entiyl  cpu 2024/02/08 17:07:27 cpu issue i i

[ sior | aX320WBI0T testl cpu 2024/02/08 120743 pu nif

nifi

Figure 9 - Refresh View Data Events

3.2.1.5 Live Events Data

This option will enable user to stop/start live update of data being shown in grid. Please follow below steps

to enable/disable live events.
1. In the top navigation bar, click on Data View and click on Events.
2. Users can see the Live Events Data, and this will be updated reqularly, and automatically refresh the grid.

3. To stop live data update, please click on Live button, it stops updating the live event data, a confirmation

message will appear, stating that “Auto - refresh has been disabled.”

Data View > Events

Select Events View Events hd @ S 8 B R

%
» - I N -
All Je Critical ® Major N Minor J Warning J (* Clear ® Indeterminate )

Severity 1D Entity  Parameter Event Time Title Manager Primary Application Name ToolID  Secondary Application Name Agent

[ Magor | SUGRPHMIXT entiy2  memory 2024/02/09 17:07:31 memory issue if nif

B rovcanaw enityd  swap 2024/02/09 17:07:31 swap issue nif if

[ Major | XIXTAT7ZNES entiy!  cpu 2024/02/09 17:0727 cpuissue i nif

[ maior | 8X32CWBI0T test] cpu 2024/02/09 12:07:43 cpu nifi

Figure 10 - Live Events Data

3.2.1.6 Apply Filters
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This option will enable user to apply filters over currently opened view to see data of specific values. For
e.g., to see list of critical events, user can set filters over severity columns of events ‘data. Please follow
below steps to apply filters:

1. In the top navigation bar, click on Data View and click on Events.

2. Click on the filter option present at right side of Live button as shown in figure.

Data View > Events

Select Events View  Events v - S B R
(an )( e ciitical )(_® Major )(_» Minor )(_e warning )( @ Clear )(_® Indeterminate
Severity 1D Entity  Parameter  EventTime Title Manager  Primary Application Name Tool ID  Secondary Application Name Agent

XIXTATINGD entity1 cpu

BX32CWBIOT test1 cpu

Figure 11 - More Filter Operation
3. Afilter screen will come up which enables user to select field and corresponding operator along with

value to filter data.

Data View > Events

Select Events View Events v < Live S B R

Fields Operator Value

Parameter v LIKE v [+]

Figure 12 - More Filter Operation

3.22 Alerts
“Alerts" refer to notifications or warnings generated by monitoring systems or tools when significant
events or issues are deviating from normal system behavior. Alerts play a crucial role in proactively
identifying potential problems, anomalies, or security incidents within the IT environment. Alerts are
triggered by a monitoring system to indicate the occurrence of a specific event or condition that requires
attention. Alerts are typically generated based on predefined rules, thresholds, or conditions associated
with events. Multiple alerts may be correlated to identify patterns or relationships between different
events, helping in understanding the broader impact.
Well-designed alerting view provides IT teams with crucial information, enabling them to respond

proactively to potential issues and minimize the impact on operations.
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This option will enable user to view list of all alerts those have been created in HCL IEM. Please follow
below steps to view alerts:
1. In the top navigation bar, click on Data View and click on Alerts.

2. Alert data will be displayed for the customer logged-in is part of.

Data View > Alerts

Select Alerts View Alerts v - S B R

an ¢ N N Y N avd FUY
\nl\ /I‘\o Critical _/‘\\ Ma;ol)‘\_ Minor /I.\ Warning AN Cear/‘.\_c Indetermmate/

] Severity D Entity Parameter Occurrence Pending Since Last Updated

] *BWGOgSNTy entity3 swap 1 2024/02/09 17:07:31 2024/02/09 17:07:31

1 HshLVSAFZX entity2 memary 1 2024/02/09 17:07:31 2024/02/09 17:07:31

J iwamTmDzsR entity1 pu 1 2024/02/09 17:07:27 2024/02/08 17:07:27

] QidReWHPke testl cpu 1 2024/02/09 12:07:43 2024/02/09 12:07:43

Figure 13 - Alerts View

This option will enable user to save currently opened view with columns populated in data grid so that
same view can be shown to any other user in an organization. It is very helpful for admins to configure this
kind of view for other users in an organization by creating a different view other than current view. For e.q.,
view to list out events with critical severity only. Please follow below steps to save as events:
1. In the top navigation bar, click on Data View and click on alerts.
2. Once the user can click the save as button, a pop-up will open to provide following information:
e View Name: name of view like critical alerts
e Description: description of view like list all critical alerts
e Show to: Either it will be visible to user who is saving it or to other users.

3. Next, click on save button to save view.

Save As X
View Name Description

Show to

My Self v

Figure 14 - Save As Alerts

4. This view will be available in list for users as shown in figure.
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Data View > Alerts

Select Alerts View Alerts v - S B R
Select B
w ?
alerts J —
LA (- Critical ® Major . Mincr}( Waming)C- C\ear)(- InderermnnateJ

Severity D Entity Parameter Occurrence Pending Since Last Updated

*BWaOgSNTy enti3 swap 1 2024/02/09 170731 2024/02/09 1720731
HshLVSAFZX entity2 memary 1 2024/02/09 17.07:31 2024/02/09 17:07:31

iwdmTmDzsR entityl cpu 1 2024/02/09 17:07:27 2024/02/08 17:07:27

m]

QidReWHPke test! cpu 1 2024/02/0912:07:43 2024/02/09 12:07:43

Figure 15 - Select Alerts View Dropdown

3.2.23 Add Column

This option will enable user to add more columns in data grid to analyse it deeply. Please follow below
steps to add columns to data view.
1. Inthe top navigation bar, click on Data View and click on Events.
Click on the Add Column action button present at right side of Live button.
3. A pop-up will open which enables user to select from list of available columns to add it in the grid as

shown in figure. Then, click on save button to add selected columns in view.

Add Columns X
Add More Columns

Sub Entity ID v

Original Columns

T Severity X T ID X T Entity X O Parameter X T SubEntity ¥ T PendingSince X T last Updated X

~
o Occurrence %

Newly Added Columns

C SubEntityID X

Figure 16 - Add Column

3.2.2.4 Related Events

This option will enable user to see related events for selected alert to see what all events have been

combined to create an alert.
1. Inthe top navigation bar, click on Data View and click on Alerts.

2. Click on a particular alert on Data View-Alert screen, then it will populate list of related events as

shown below in figure.
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swap issue

o X
Pending Since
024 17:07:31 'd N
2024/02/09 17:073 (events )
\. J
Last Occurrence
2024/02/09 170731
Description E
swap issue
Severity D Event Time Entity Title Event Created On Parameter
Severity
Major
[ aor ] FCBMCADCOH 2024/02/09 17:07:31 entity3 swap issue 2024/02/09 17:07:31 swap

Figure 17 - Alerts Related Events
3.2.2.5 Refresh Alerts

This option will enable user to refresh data grid to populate latest alerts data over screen.

Please follow below steps to refresh alerts grid:
1. Inthe top navigation bar, click on Data View and click on alerts.

2. Once the user clicks on Refresh button, confirmation pop up message will appear.

Data View > Alerts

Select Alerts View  Alerts ~ l - BT T T = < Live S B R
2
N I N Y
All . (nll(al) ® Major Minor Warning J{ @ Clear L] \ndetsrmmale/
[m] Severity D Entity Parameter Occurrence Pending Since Last Updated
(u] [ Major | xBwqOgSNTy entity3 swap 1 2024/02/09 17:07:31 2024/02/09 17:07:31
a = HshLVSAFZX entity2 memory 1 2024/02/09 1707:31 2024/02/09 17:07:31
o [ Major | wdmTmDzsR entity1 pu 1 2004/02/09 17:07:27 2024/02/09 17:07:27
a [ wisior | QiReWHPke testl pu 1 2024/02/09 12:07:43 2024/02/09 120743

Figure 18 - Confirmation Message

3.2.2.6 Live Alerts Data

This option will enable user to stop/start live update of data being shown in grid. Please follow below steps

to enable/disable live alerts.
1. Inthe top navigation bar, click on Data View and click on alerts.
2. Users can see the Live Alerts Data, and this will be updated regularly, and refresh grid.
3. To stop live data update, please click on Live button, it stops updating the live alerts data, a

confirmation message will appear, stating that “"Auto - refresh has been disabled.”
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Data View > Alerts

Select Alerts View  Alerts v EL‘.‘ =] [

o civcal ) (e waior )(o_minor ) (o Waming )(Ce_dear ) (@ indererminate )

(u] Severity D Entity Parameter Oceurrence Pending Since. Last Updated

o R — . 3 e — R —
0 = - . - , [E—— T —
0 3 e vy = . —— ——
0 == R - - . R R

Figure 19 - Live Alerts Data
3.2.2.7 Apply Filters

This option will enable user to apply filters over currently opened view to see data of specific values. For

e.g., to see list of critical alerts, user can set filters over severity columns of alerts’ data. Please follow

below steps to apply filters:
1. Inthe top navigation bar, click on Data View and click on alerts.
2. Click on the filter option present at right side of Live button as shown in figure.

3. Afilter screen will come up which enables user to select field and corresponding operator along

with value to filter data as shown in figure.

Data View > Alerts

Select Alerts View  Alerts b - S B R
(@]

Fields QOperator Value

Entity hd LIKE v 1

Figure 20 - More Filter Operation

4. Users can see the result of applied filter.

Data View > Alerts

Select Alerts View  Alerts b

| Applied Filters | Entity 151 x | iv
(a) (o catiea) (o wajor ) (o wtinor ) (o worning ) (o lear ) (o _indeterminate )

] Severity D Entity Parameter Occurrence Pending Since Last Updated

m] Major iwamTmDzsk entity1 cpu 1 2024/02/09 17:07:27 2024/02/09 170727

] QidReWHPke testl pu 1 2024/02/09 12:07:43 2024/02/09 12:07:43

Figure 21 - More Filter Operation
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3.2.3 Actionable
“Actionable" refers to a specific occurrence or situation that disrupts normal IT operations and requires
attention, investigation, and resolution. Actionable are typically identified based on events or alerts
generated by monitoring systems, and their management involves a structured and coordinated response
to minimize the impact on the organization's IT services. Actionable are identified through the correlation
and analysis of alerts, or anomalies detected by monitoring systems over HCL IEM. Efficient Actionable
creation depends upon how effective alert correlation is happening over the system. Actionable progress
through various stages in their lifecycle, including detection, identification, classification, investigation,
resolution, and closure. It includes root cause analysis to identify the underlying factors that led to the

actionable, helping in preventive actions.

Please follow below steps to view events data:
1. In the top navigation bar, click on Data View and click on actionable.

2. Alerts data will be displayed for the customer to which user is part of.

Data View > Actionable

Select Actionable View Actionable v & Live a 9 B8 ®

A ) ( cal ) Aajor ) ( or ){_® Waming ){ e Clear )( d ate ) A -
(LA )( e critical )( @ Major )( o Minor )( aming ) (_ r )(_® Indeterminate ) Select State Al

Severity 1D State  RuleName Entity  Title Pending Since Last Updated Correlated  Is Actionable  Description Parameter  External Ticket Number

Closed Time & Location Based  entityl  cpu issue

Figure 22 - Actionable View

This option will enable user to add more columns in data grid to analyse it deeply. Please follow below
steps to add columns to data view.

1. Inthe top navigation bar, click on Data View and click on alerts.

2. Click on the Add Column action button present at right side of Live button.

3. A pop-up will open which enables user to select from list of available columns to add it in the grid as

shown in figure. Then, click on save button to add selected columns in view.
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Add Columns X

Add More Columns
Entity v
Original Coelumns
o~ ~ -~

O Severity X T ID X O PendingSince X T lastUpdated X T Tite X T State X T RuleMame X

C  biernal Ticket Number X O Environment X O Location X

Newly Added Columns

C Entity X

Figure 23 - Add Column
3.2.3.3 Related Changes and Related Problems

This view enables user to see related changes and problem corresponding to entity for which actionable
has been created as this could one of root cause for change and problem creation. Below are steps for
accessing related changes and problems.

1. Click on a particular actionable on Data View-Actionable screen, it will open up pop-up window.

2. Next, click on Related Changes or Related Problems tab.

3. Related changes and problems will be populated in card as shown in figure.

test Change Severity Change State S = @ X

Pending Since

Assign Users
2023/02/13 1410:33

Last Occurrence Select User to be assigned

2023/02/13 1410:38

(roptony ) (Seven oty ) (Temsine) (o) (Gommens) (o e ) e e

Test_AllLevel

Description
ese change IR

Assigned User

— CHG0030078'>CHGO0300" . CHGO030065
2023-01-30 07:10:00 = 2023-01-30 06:42:16

State
Closed

Increase db_block_buffers from 50... CPU issue - Threshold crossed.

Figure 24 - Related Changes
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test m Change Severity m Change State O = B x

Pending Since Assign U
2023/02/13 1410:33
Select User to be assigned

Last Occurrence

2023/02/13 14:10:38

Rule based correlation (Tcpolugy) (Sennce Hisrarchy) (Timel\nes) (Adm(les) CCOmmenls) CHislnm:al Dm) ( Related Tickets )
Test_AllLevel S~ —
Description

Assigned User

Severity

Minar 2 PRB0040032 = PRB0040039

State 2023-01-30 07:15:59 2023-01-30 07:20:16
Closed

Issue with routing Switch occasionally drops connecti...

Figure 25 - Related Problems

3.23.4 ChatBot

The steps involved to initiate a chat with a particular user over the chat window are given as follows:
HCL IEM enables collaboration amongst team members via chat room functionality. It also provides
integration with HCL Lucy in case operator wants to fetch some information related to actionable over
which user is working on:
1. Click on a particular actionable on Data View-Actionable screen, then go to pop up opened for the
actionable.
Click on the chat icon present over the header of the actionable popup.
3. Actionable title resembling issue description is mentioned over the chat window. The user can

initiate chat with the invited user as shown.

cpu issue Change Severity v cpu issue

Pending Since Assign U —
202402709 17:07:27 + Invite User |

Select User to be assigned

o

Last Oceurrence

2024/02/09 17:07:31

) Severity 1D Title Entity Last Updated
Severity
Major HshLVSAFZX memory issue entity2 2024/02/09 1707:31

xBwqOgSNTy  swap issue entity3 2024/02/09 17:07:31

wdmImDzsR  cpuissue entityl 2024/02/09 17:07:27

Figure 26 - Chat Bot

4. After Click on + Invite User, user can select the user from dropdown shown below.
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nvite Users

anshul.mishra@dryiceiem.com

anshul. mishra@dryiceiem.com
devuser@dryiceiem.com
jaianand.mohan@dryiceiem.com
johan.bob@dryiceiem.com
naveenkumar@dryiceiem.com

streamuser@dryiceiem.com
sujanisingaraju@dryiceiem.com
superadmin@hcl.com

tamizhmani.ponnusamy@dryiceiem.com

Figure 27 - Invite User

5. After successful invitation, confirmation message will be displayed.

cpuissue

Pending Since
2022/02/09 17:07:27

Rule based cormelation
Hetwork Topolegy

Assigned User
Severty
Wajor
state
In Progress

Assign Users

Select User|
l @ User invited successfully.

Change Severity v ([ cPu issue

X

R :

] Title Entity
HhIVSAFZX  memory issue  entity2
XBwqOgSNTy  swap issue entity3

iwdmImDzsR  cpu issue entityl

Figure 28 - Alert Message

Occurrence

7

1

,

Last Updated
2024/02/09 17.07:31
2024/02/09 17.07:31

2024/02/09 17:07:27

Type here. >

Note: This chatbot may collect persongl inframation that you voluntorily
provide. such as your name. email oddress, or any other information you
choese to shar

3.2.3.5 Add Comments

HCL IEM enables user to provide comments that user has been performing while solving issues. Please
follow below steps to add comments in actionable screen:

1. Click on a particular actionable on Data View-Actionable screen, a pop-up window will open up that

will show all information like related alerts, related changes, related problems, timeline view,

topology view, service topology view etc.

Click on the Comments header present in the actionable popup.

Details of comments along with posted user will be displayed over screen.

It also provides an option to search for a specific comment by entering text in search box.
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cpu issue

Pending Sincs
2024/02/09 1707:27

2024/02/09 1707:31

Rule based correlation

Network Topology
Description
<pu issue

Jned User
Major
State
In Progress

+ Create Ticket

3.2.3.6 Activities

I changeSeverity v [N cChangestate v 5 3 B B X

Assign Users

Select User to be assigned

nerts ) ( Topology ) ( Service Hierarchy ) . Comments ;<Hisro-rm Da\a) (Relaled mers)

Netwaork Topology

Submit

Description is cpu 2

2024/02/09 18:31:30
- dryiceiemadmin@dryice.com

o Severity is major.

2024/02/09 18:30:53
- dryiceiemadmin@dryice.com

Figure 29 - Add Comments to Actionable

HCL IEM records list of activities system or user has performed while analysing events, alerts and

actionable. Please follow below steps to list out activities:

1. Click on a particular actionable on Data View-Actionable screen, a pop-up window will open up that

will show all information like related alerts, related changes, related problems, timeline view,

topology view, service topology view etc.

2. Click on the Activities header present in the actionable popup.

3. Detailed view of changes in the logs for that actionable and its related activities will be visible as

shown.

4. Search tab is present to specifically search for a log present in the activity view.
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cpu issue
Pending Since
2024/02/09 17:07:27
2024/02/09 17:07:31
Network Topology
escriptio
cpu issue
Assigned User
Major

In Progress

Assign Users

Select User to be assigned

reoie ) (Gammens ) (i o) (e ke )

Type

Comment Added
Comment Added
Invited Users

stream action

stream mapping update
stream mapping update
alert emit state update
alert emit state update

alert emit state update

ctvnams actlan

m Change Severity v

Date Time

2024/02/09 13:01:30
2024/02/09 13:00:53
2024/02/09 12:59:23
2024/02/09 11:54:59
2024/02/09 11:54:59
2024/02/09 11:54:29
2024/02/09 11:53:57
2024/02/09 11:53:52

2024/02/09 11:53:52

Change State v

User Activity

user dryiceiemadmin@dryice.com added comment

user dryiceiemadmin@dryice.com added comment

user dryiceiemadmin@dryice.com invited users

actionable updated

updated as related actionable for actionableickrRgJ!

updated as related actionable for actionableid:rRg)l.

related alert emitted from state iwdmTmDzsR

related alert emitted from state HshLVSAFZX

related alert emitted from state xBwqOgSNTy

3.2.3.7 Historical Data

Figure 30 - Activities

HCL IEM enables operators to view similar actionable related to current actionable. This works by

comparing entity+parameter combinations for current actionable and compare with historical actionables

to identify and populate matching actionables. Please follow steps to view similar actionables.

1. Click on a particular actionable on Data View-Actionable screen, a pop-up window will open up that

will show all information like related alerts, related changes, related problems, timeline view,

topology view, service topology view etc.

Click on the Historical Data header present in the actionable popup.

3. Historical Data containing details of similar actionable will be displayed and details can be seen while

scrolling from left to right for similar actionable.

cpu issue
dending Since
2024/02/09 17:07:27

_ast Occurrence

2024/02/09 17:07:31

Rule based correlation
Network Topology
Jescription

“pu issue

ned User

Vizjor

n Progress

+ Create Ticket

Assign Users

Select User to be assigned

g N
( Topology ) ( Service Hierarchy ) ( Timelines (Comments) (( Historical Data /‘CRelated Ti(ke(s)

m Change Severity v

Severity 1D State  RuleName

rSjljotkEb Closed Time Based

TaQgKT3Mx  Closed Time Based Clone

Change State v

Entity Titile Pending Since

entity1

aQM1fk3CH7 Closed Entity and Time Based  entity1

entity1

2024/02/09 17:07:27

2024/02/09 17:07:27

2024/02/09 17:07:27

Last Updated c

2024/02/0917:07:31 3

2024/02/0917:07:27 1

2024/02/09 17:07:31 3

S B 8 X
v

D p Exte

cpu issue cpu

cpuissue cpu

cpu issue cpu

Figure 31 - Similar Actionable
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HCL IEM provides service hierarchy view to for service corresponding to which actionable got created. This
enables operator to understand what other service can be impacted due to this. Please follow below steps
to access service hierarchy tab:

1. Click on a particular actionable on Data View-Actionable screen, a pop-up window will open up that
will show all information like related alerts, related changes, related problems, timeline view,
topology view, service topology view etc.

2. Click onthe Service Hierarchy tab present in the actionable popup.

3. Service Hierarchy provides visualization of services relationships along with their impact based on
current events in system.

4. Impacted services can be highlighted as per configured color codes and level of impact.

cpu issue Change Severity v Change State v SO 3 B &3 x
Assign Users
2024/02/09 17:07:27
Select User to be assigned ¥
2024/02/09 17:07:31
s W =\ (ﬁ/’ﬁ, 3 ( \/ 5 N\
R ( Ale Topolo ervice Hierarch Timel ( Activities ) ( Comments ) ( Historical ) ( Related Tickets
e (Aerts ) ( Topology ) (_Timelines ) ( Activities ) ( Comments ) ( Historical Data ) ( Related Tickets )

Mycloud

In Progress ideploy
Y

MyCloud DR

+ Create Ticket

Figure 32 - Service Hierarchy

Visualizing complete timeline when event came in, when alert got created and how actionable got
combined is very difficult to understand. HCL IEM provides a way to present this information in timeline
manner where events, alerts and associated actionable will be shown over time scale. Please follow below
steps to access timeline view:
1. Click on a particular actionable on Data View-Actionable screen, then go to pop up opened for the
actionable.
2. Click onthe Timelines header present in the actionable popup.
3. Timeline view will be visible under the header, and details can be seen while scrolling from top to
bottom to check the timestamp of events and alerts for that actionable.
4. Entity, Parameter, Description and Timestamp are displayed for Event/Alert/ Actionable in the

timeline view.
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5. There are different icons for differentiating between events, alerts and actionable, and different

color codes as per severity.

cpu issue B change severity v ChangeState ¥ & @ @ & X

Pending Since

Assign Users
2024/02/09 17:07:27

Select User to be assigned ™

Last Occurrence
2024/02/09 17:07:31

Rule based correlation (Tapalogy) (Service Hierarchy) (Tlme\mes) Activities (Comments) (His(orical Da!a) (R&iated Ticke(s)

Network Topology

Description =
Sl : 2024/02/09
entity1
Assigned User ity 17:09
Severity cpu
M g
o cpu issue
State
In Progress
2024/02/09
@ entity2 17 .048/0
memory

memory issue

) 2024/02/09 @
entity1 17:08

cpu

+ Create Ticket cpu issue
-

Figure 33 - Timelines

3.2.3.10 Change Severity

Operators can modify severity of actionable based on their understanding. Please follow below steps to
change severity of actionable.
1. Click on a particular actionable on Data View-Actionable screen, then go to pop up opened for the
actionable.
Click on the severity Clear/Indeterminate/Warning/Minor/Major/Critical as shown.

3. Adialog box would appear for confirmation.

cpu issue I  change Severity v Changestate ¥ & m @ & X

Pending Since

Assign Users | Critical
2024/02/09 17:07:27 !
| Major
Last Occurrence Select User to be assigned | Minor v

2024/02/09 17:07:31

Warning
Rule based correlation (‘opology ) ("sevice Hierarchy ) ("Timelines ) Inderterminant  ftorical Data ) (Related Tickets
Clear

Network Topology

Description =]
cpu issue

AR Severity ID Title Entity Occurrence  Last Updated Parameter  Pending Since Location  Environment
Severity
Major T  Hshwsarzx memoryissue  entiy2 1 2024/02/0917:07:31  memory 2024/02/0917:07:31  Noida prod
State
In Progress T ewqogsNTy  swapissue entityd 1 2024/02/09 170731 swap 2024/02/0917:07:31  Noida prod
I iwemTmOzR  cpuissue entity! 1 2024/02/0917:07:27  cpu 2024/02/0917:0727  Noida prod

+ Create Ticket

Figure 34 - To Change Severity of Actionable
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Operators can modify or change status of actionable based on current state of work. Please follow below
steps to change status of an actionable.
1. Click on a particular actionable on Data View-Actionable screen, then go to pop up opened for the
actionable.
2. Click on the status Open/Assigned/In Progress/Resolved.

3. Adialog box would appear for confirmation.

cpu issue Change Severity v In Progress. Change State v S 3 B 6 X
‘ Change State
i bl Assign Users Open
2024/02/09 17:07:27 :
Assigned
| Last v Select User to be assigned v
| 2024/02/09 17:07:31 Resoked
| Rute based correlatio ( nerts ) (Topo\og)') (Ser‘u(e H\erarchy) (Txmehnes)( Activites ) (_Comments ) (_Historical Data @9256.‘1._-/
| Network Topology
cpu issue 8
| it Severity ID Title Entity Occurrence  Last Updated Parameter  Pending Since Location  Environment
f Moy | Major HshLVSAFZX ~ memoryissue  entity2 1 2024/02/09 17:07:31  memory 2024/02/09 17:07:31  Noida prod
In Progress [ Major xBwqOgSNTy  swap issue entity3 1 2024/02/09 17:07:31  swap 2024/02/0917:07:31  Noida prod
iwdmTmDzsR  cpu issue entityl 1 2024/02/09 17:07:27  cpu 2024/02/0917:07:27  Noida prod

+ Create Ticket
T

Figure 35 - To Change Status for Actionable

User with tenant admin role can assign actionable to their team members based on their availability. Please
follow below steps to assign actionable to user.
1. Click on a particular actionable on Data View-Actionable screen, then go to pop up opened for the
actionable.
2. Click on Assign to header present in the actionable popup. The dropdown list of users configured in
the environment will be displayed.
Click on the user assigned for that actionable as shown.
4. Notification will be sent to the user after the actionable is assigned.
Notification will be sent to the user even when the assigned actionable will be released from the

user.
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cpu issue Change Severity v ChangeState ¥ & @ B [:j. X

Pending Since

3 Assign Users

2024/02/09 17:07:27

it Ocslimenics Select User to be assigned [ v
R Select User to be assigned

Rule based correlation | Assign to self

Network Topology Jjohan.bob@dryiceiem.com

Description tamizhmani.ponnusamy@dryiceiem.com

cpu issue jaianand.mohan@dryiceiem.com

sujanisingaraju@dryiceiem.com

naveenkumar@dryiceiem.com

devuser@dryiceiem.com

streamuser@dryiceiem.com

superadmin@hcl.com

anshul. mishra@dryiceiem.com

iwAmTmDzsR  cpu issue entiyl 1 2024/02/0017:0727  cpu 2024/02/0917:0727  Noida prod

Minor

State

In Progress

+ Create Ticket

Figure 36 - Assign Actionable to Another User

3.2.3.13 Save As Actionable

This option will enable user to save currently opened view with columns populated in data grid so that
same view can be shown to any other user in an organization. It is very helpful for admins to configure this
kind of view for other users in an organization by creating a different view other than current view. For e.qg,,
view to list out actionable with critical severity only. Please follow below steps to save as actionable:
1. Inthe top navigation bar, click on Data View and click on actionable.
2. Once the user can click the save as button, a pop-up will open to provide following information:
e View Name: name of view like critical actionable
e Description: description of view like list all critical actionable
e Show to: Either it will be visible to user who is saving it or to other users.

3. View with name "Critical Actionable” is created.

Save As X
View Name Description

Show to

My Self ~

Figure 37 - Save As Actionable

3.2.3.14 Refresh Actionable

This option will enable user to refresh data grid to populate latest actionable data over screen.
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Please follow below steps to refresh alerts grid:
1. Inthe top navigation bar, click on Data View and click on alerts.

2. Once the user clicks on Refresh button, confirmation pop up message will appear.

Data View > Actionable

Select Actionable View Actionable v I e e X Z Live L E =] R

(Al )l e (rm(al)‘ ® Major ( Mmor)‘ wammg>- ® Clear ‘Co Indeterminate ) Select State  All e

O Severity 1D State  RuleName Entity Title Pending Since Last Updated Correlated s External Ticket Number

RglBskhc  Assigned  Network Topology entityl]  cpuissue 0240209170727 20240209 170731 3 ¥ cpuissue Pu

BB oo Cosed  Systemload entity2 Systemunderload  2024/02/09 170731 2024/02/08 170731 1 ¥ System underload  memory

) coeszeid  Cosed  Systemioad entity3 Systemunderioad  2024/02/09170731  2024/02/08 170731 1 % System underload  swap

) onkwH  Closed  Time&locstionBased  entityl cpuissue 2024/02/09 170727 2024/02/09 170731 3 Y cpuissue @u

23 s Closed  Time Based entityl  cpu issue 2024/0209170727 20240209 170731 3 v cpu issve Pu

m iOhNFgKaql  Closed Entity and Time Based  entity3  swap issue 2024/02/091707:31  2024/02/09 170731 1 ¥ swap issue swap

D vrane Closed  Entityand TimeBased  entity2  memory issue 2024/02/09170731  2024/02/09 170731 1 Y memory issue memory

I woimmx Cosed  Time Based Clone entity!  cpu issue 2024209170727 0240209170731 3 ¥ pu issue wu

m FNcsevAEsX Closed System Load entityl  System under load 2024/02/08 170727 2024/02/09 170727 1 Y System under load Ppu

Figure 38 - Refresh time for Actionable

3.2.3.15 Live Actionable Data

This option will enable user to stop/start live update of data being shown in grid. Please follow below steps
to enable/disable live actionable.

1. Inthe top navigation bar, click on Data View and click on actionable.

2. Users can see the Live Actionable Data, and this will be updated regularly.

3. To stop live data update, please click on Live button, it stops updating the live actionable data, a

confirmation message will appear, stating that “"Auto - refresh has been disabled.”

Data View > Actionable

Select Actionable View Actionable v EO S 8 R

@
(\ﬂ) (@ ciitical ) (» Major ) (s Minor ) (e wamning ) (e clear ) (@ Indeterminate ) Select State | Al %

Severity 1D State  RuleName Entity  Title Pending Since Last Updated Correlated s External Ticket Number

RgiBskhc  Assigned  Network Topology entityl  cpu issue 2004/02/09 170727 2024020917071 3 Y cpuissue Pu

BB onatou  Cosed  SystemLoad entity2 Systemunderioad 202400209 170731  2024/020917:0731 1 v System underload  memory

) cceszGd  Cosed  SystemLoad entity3  Systemunderioad  2024/02/09 170731  2024/02/09170731 1 v System underioad  swap

B onuH  Cosed  Time&locationBased  enttyl  cpuissue 2024/02/09 170727 2024/0209170731 3 Y cpu issue pu

£ sijone Closed Time Based entityl  cpu issue 20240209 170727 202400209 170731 3 ¥ cpu issue pu

m iOhNFgKaq1 Closed Entity and Time Based entity3 SWap issue 2024/02/09 170731 2024/02/09 1707:31 1 Y SWap issue swap

Figure 39 - Live Actionable Data

3.2.3.16 Related Alerts

This option will enable user to see related alerts for selected actionable to see what all alerts have been
combined to create an actionable.

1. Inthe top navigation bar, click on Data View and click on actionable.
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2. Click on a particular actionable on Data View-Alert screen, then it will populate list of related alerts

as shown below in figure.

o= Change Severity v Changestate ¥ 5 m B & X

Assign Users

Select User to be assigned ~

| 2024/02/09 17:07:31

elatic | Alerts ) ( Topology Service Hierarchy Timelines (Commwrs) (H\sroﬂ:a\ Da(a) (Re\ated T\ckets)

Rule based co
Network Topology

| cpu issue 8
o) Severity 1D Title Entity Occurrence  Last Updated Parameter  Pending Since Location  Environment
tamizhmani.ponnusamy@dryiceiem.com
HshlVSAFZX ~ memoryissue  entity2 1 2024/02/08 17:07:31  memory 2024/02/0917:07:31  Noida prod
Minor
xBwqOgSNTy  swap issue entityd 1 2024/02/09 17:07:31  swap 2024/02/0917:07:31  Noida prod
Assigned
t iwdmTmDzsR  cpu issue entityl 1 2024/02/0917:07:27  cpu 2024/02/0917:07:27  Noida prod
|
|

| + Create Ticket

Figure 40 - Actionable Related Alerts

HCL IEM provides topology hierarchy view for entity corresponding to which actionable got created. This
enables operator to understand what other entities can be impacted due to this. Please follow below steps
to access topology tab:

1. Click on a particular actionable on Data View-Actionable screen, a pop-up window will open up that
will show all information like related alerts, related changes, related problems, timeline view,
topology view, service topology view etc.

2. Click on the topology tab present in the actionable popup.

3. Topology provides visualization of entities relationships along with their impact based on current
events in system.

4. Impacted entities can be highlighted as per configured color codes based on level of impact on

Impacted entities.
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cpu issue I8 change Severity v Changestate v & m 8 & X

Pending Since

Assign Users
2024/02/09 17:07:27

Last Occurrence Select User to be assigned ~
2024/02/09 17:07:31

Rule based correlation Topology Service Hierarchy Timelines Activities (Comments) CHislarical Da(a) CRelated Tickets)

Network Topology

Description
cpu issue View Complete Topology
Assigned User -m.nw
tamizhmani.ponnusamy@dryiceiem.com &

Severity
Minor

State entityd  entity2  entity3
Assigned

+ Create Ticket

Figure 41 - Topology

3.2.3.18 Create Ticket

HCL IEM enables operator to create ticket if not created automatically as part of configured correlation
rule. Please follow steps to create ticket for an actionable in HCL IEM.
1. Click on a particular actionable on Data View-Actionable screen, then go to pop up opened for the
actionable.

2. Click onthe + create ticket icon present in the actionable popup.

Only operator with relevant role would be able to create ticket in SNOW.

cpu issue Change Severity v ChangeState ¥ & s B B X

Pending Since
2024/02/09 17:07:27

Assign Users
Last Occurrence Select User to be assigned w
2024/02/09 17:07:31

. N\
Rule based carrelatian (A\ﬂis ) | Tepology Service Hierarchy (Cammems) CH\slurica\ Data) (Related kaets)

Metwork Topology

Description
Cpu issue E
Asigned User Severity 1D Title Entity Occurrence  Last Updated Parameter  Pending Since Location  Environment

tamizhmani ponnusamy@dryiceiem.com

Severity ) Hshwsarzx memoryissue  entiny2 1 2024/02/08 17:07:31  memory 2024/02/0917:0731  Noida prod
Minar
State XBwqOgSNTy  swap issue entiyd 1 2024/02/09 170731 swap 2024/02/09 170731 Noida prod
Assigned

) weanTmDzsk  cpuissue entityl 1 2024/02/08 170727 cpu 2024/02/09 170727 Noida prod

+ Create Ticket

Figure 42 - Create Ticket

4. A confirmation pop up message will appear.

IEM User Guide



Create Ticket X

Are you sure you want to create a ticket for the selected
actionable?

Figure 43 - Create Ticket Confirmation

3. Users can Create Ticket to an actionable by clicking on the confirm button.

3.2.3.19 Apply Filters

This option will enable user to apply filters over currently opened view to see data of specific values. For
e.g., to see list of critical actionable, user can set filters over severity columns of actionables’ data. Please
follow below steps to apply filters:

1. Inthe top navigation bar, click on Data View and click on actionable.

2. Click on the filter option present at right side of Live button as shown in figure.

Data View > Actionable

Select Actionable View Actionable ~ - 8 & B ?

Al Co Critical ) (_® Major ) ( Minor )- Warning ) (e Cleart)k. Indetsrminate) Select State  All v
L) severity 1D State RuleMame Entity  Title Pending Since Last Updated Correlated  Is Actionable  Description Parameter  External Ticket Number
1 RgliBskhe Assigned  Metwork Topology entityl  cpuissue 2024/02/09 170727 2024/02/09170731 3 Y cpu issue cpu
O P o/NoiMxUyH  Closed  System Load entity?  Systemunderload  2024/02/09 170731 2024/02/09 170731 1 ¥ System under load  memory
O M cosmszGid  Cosed  Systemload entityd  Systemunderload  2024/02/091707:31  2024/02/08 170731 1 ¥ System under load  swap
I  okpriuwH Closed  Time & Location Based  entityl  cpuissue 2024/02/09 170727 2024/02/0917.0731 3 ¥ cpu issue cpu
) sione Closed  Time Based entityl  cpu issue 2024/02/08 170727 2024/02/09 170731 3 ¥ cpu issue cpu
O [ ohnrgksql  Closed  EntityandTimeBased  entityd  swapissue 2024/02/09 170731 2024/02/09 170731 1 ¥ swap issue swap
O M cfvromne Closed  Entityand Time Based  entiy2  memory issue 2024/02/09 170731 2024/02/09 170731 1 Y memory issue memory
O EE ©0TMx Closed  TimeBased Clone entityl  cpu issue 2024/02/09 1707:27  2024/02/09 170731 3 v cpu issue pu
BT uceix Cosed  SystemLoad entityl  System underload  2024/02/09 170727 2024/02/0917.0727 1 Y System under load  cpu

Figure 44 —Filter Operation

3. Afilter screen will come up which enables user to select field and corresponding operator along with

value to filter data as shown in figure.
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Data View > Actionable

Select Actionable View  Actionable ~ - 8 8 B R

Fields Operator Value
Title - LIKE ~ System

Eaen
(o critical ) (@ Major ) (e minor )("e warming ) (e clear )((® Indeterminate ) Select State Al v

1 Severity 1D State  RuleName Entity  Title Pending Since Last Updated Corelated  Is Actionable  Description Parameter  External Ticket Number
O 50 rAgieskhc  Assigned  Network Topology entity!  cpuissue 2024/02/09 170727 2024/02/09 170731 3 v cpuissue pu

O [EEE) e™oMxUyH  Closed  SystemLoad entity2  Sysemunderkoad  2024/02/09 170731 2024/02/09 170731 1 v System underload  memory %

O ([ ccisszGid  Closed  SystemLoad entityd S et load 170731 70731 1 ¥ System under losd  swap

O [EEE okt Closed  Time&Location Based  entityl  cpuissue 2024/02/00 170727 2024/02/09 170731 3 ¥ cpuissue pu

m] 1Siljotkeb Closed  Time Based entityl  cpuissue 2024/02/00 170727 2024/02/08 170731 3 ¥ cpu issue pu

Figure 45 — More Filter Operation

Data View » Actionable

Select Actionable View  Actionable v - 2 T B R

|N:|:|h'edfil|ﬂs [ Tite 15 system |

(. Critkal)(- Majar)(- Minnr)(- waming)(- C\ear)(- Ir\delerminate) Select State  All ~

o State  RuleName  Entity  Title Pending Since Last Updated Correlated s Acti ipti External Ticket Number
G7NGINXUyH  Closed  Systemload  entity2  Systemunderload  2024/02/09 170731 202402009 170731 1 ¥ System underload  memary

GC1835ZGid  Closed  Systemicad  entityd  Sysemunderioad  2024/02/09 170731  2024/02/08 170731 1 ¥ Systemunderioad  swap

FNcsevAESX Closed  System load  entityl  System under load 2024/02/09 17:07:27 2024/02/09 17:07:27 1 ¥ ‘System under load <pu

dVioqaosif Open  Systemlcad test]  Systemunderload  2024/02/09 120743  2024/02/09 120743 1 ¥ Systemunderload  cpu

Figure 46 - More Filter Operation

4. Users can see the result of applied filter.

Data View > Actionable

Select Actionable View Actionable ~ - & G B R

(l Cn'lil:al) C. Majnf) (t M\'nur) (O ‘Warning ) ( - Cltar) (l Indeterminate ) Select State Al

[ severity D State  RuleName Entity  Title Pending Since Last Updated Correlated  1s b

(m] m RghiBskhe Assigned  Network Topology entity!  cpu issue 2024/02/091707:27  2024/02091707 1 3 A <pu issue Py

(] 6TNGINNUYH  Closed  System Load entity2  Systemunderload  2024/02/091707:31 202402008 170731 1 ¥ System underload  memory
a GC1B35ZGid  Closed  System Load entityd  Systemunderload  2024/02/08 170731 20240208 170731 1 ¥ System underload  swap
O @™ onuk  Closed  Time&LocationBased  entityl  cpuissue 202402000 170727 2024/02409170731 3 ¥ cpuissue pu

U @ o Closed  Time Based entity]  cpu issue 2024/02/09 1707:27 202402008 170731 3 ¥ cpu issue o

O [P onvgkaqn Closed  EntityandTime Based  entityd  swapissue 202400208 170731 2004020917031 1 ¥ ouap lssue swap
a fYRedTie  Closed  Entityand Time Based  entity2  memory issue 2024/02/09 170731 2024020917071 1 ¥ memary issue memory
O @ rnodksmx  Closed  Time Based Clone emityl  cpu issue 2024/02/09 170727 2024209170731 3 ¥ cpuissue cpu

O EES rrcseatsx  Closed  Systemload entityl  Systemunderload  2024/02/09 1707:27  2024/02/09 170727 1 ¥ System under load  cpu

Figure 45 - Select State Operation

3.2.4 All Events View
All Events View includes a grid which contains all events data that is coming to the system. It includes

noise events as well as non-noise events.

IEM User Guide

e



Please follow below steps to view All Events data:
1. Inthe top navigation bar, click on Data View and click on All Events.

2. All Events data will be displayed for the customer to which user is part of.

Select View Allevents v - S 8 R

@(o Cri(ical)(t Major >< Minar >< Warnmg><t Clear \K . Indelermlna|e>

Severity 1D Entity Parameter Event Time Title Manager Tool D Agent Environment  Location Country
11-2-c-asd-nd34b4B6AT...  enlity501 memory 2024/01/31 1871400 memory issue solarwinds solarwinds Prod Noida India

11-2-c-asd-nd3abAB6dT..  enliy500 pu 2024/01/31 181300 cpuissue solarwinds solarwinds Frad Moida India
11-2-c-asd-nd3abABodT..  enlity3 swap 2024/01/311722:00  swap issue solarwinds solarwinds
11-2-c-330-nd34b46647...  entinyl cpu 2024/01/31 171400 cpuissue solarwinds solarninds

B 2 cosondsabdstad.  entitysl pu 2024/01/31 140400 cpuissue solarwinds solarwinds Prod

11-2-c-asd-nd34b4B647...  entiysa1 memory 2024/01/3113:22:00  memory issue solarwinds salarinds Prad Noida India
8271e65e-d591-4beB-8l..  AUWIAPIAUDODT  “Virtual machine CPUusa..  2024/01/311201:18  comwmwareim2sAlar..  vRealize Operations (. VRealize Operations (R,
fibad2e-de0f42bd 86, 10123066 Starage 2024/01/31 115050 {1.361.21.13.0=521018...  Generic SNIMP - Event Generic SHIMP - Event
518eBbl6-aa18-4017-86,. 10123066 Storage 2024/01/31 115049 {1351.20.1 3.0=521018.,  Generic SNMVP - Event Generic ShIWP - Event
5f1¢1508-2280-4dde-b2.. 10123066 Storage 2024/01/31 114801 {1.351.21.130=521007...  Generic SNMP - Event Generic SHMP - Event
Show 0 v  entries .23456..32

Figure — All Events View

3.24.1 AddColumn

This option will enable user to add more columns in data grid to analyze it deeply. Please follow below
steps to add columns to data view.

1. Inthe top navigation bar, click on Data View and click on All Events.

2. Click on the Add Column action button present at right side of Live button.

3. A pop-up will open which enables user to select from list of available columns to add it in the grid as

shown in figure. Then, click on save button to add selected columns in view.

Add Columns X

Add More Columns

Sub Entity ID v
Original Columns
T Severity X U ID X T Entiy X O Title X O Manager X U Primary Application Name X T Tool ID X

C Secondary Application Name X O Agent X EventTime X { Mapped Entity ID X O Parameter Category X

 Parameter X [ location X [ Environment ¥ [ Designation X

Newly Added Columns

Z Sub Entity ID %

(:IOSE.

Figure 47 - Add Column
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3.2.4.2 Save As All Events

This option will enable user to save currently opened view with columns populated in data grid so that
same view can be shown to any other user in an organization. It is very helpful for admins to configure this
kind of view for other users in an organization by creating a different view other than current view. For e.q,,
view to list out all events with critical severity only. Please follow below steps to save as events:
1. Inthe top navigation bar, click on Data View and click on All Events.
2. Once the user can click the save as button, a pop-up will open to provide following information:
e View Name: name of view like critical events
e Description: description of view like list all critical events

e Show to: Either it will be visible to user who is saving it or to other users.

Save As X
View Name Description
Showto
Iy Self v

Figure 48 - Save as Events

3. Next, click on save button to save view and this view will be available in list for users.

3.2.4.3 Refresh All Events

This option will enable user to refresh data grid to populate latest data over screen.
Please follow below steps to refresh events grid:
1. Inthe top navigation bar, click on Data View and click on All Events.

2. Once the user can click the Refresh button, confirmation pop up message will appear.

Data View > All Events

Select View Allevents v l° Content refreshed successfully X o Live s B8 8 R
ird

E_)E- . CI'RIC.‘ll.)". * Major - 4 Minor x. Warning ) / . (Iearr') (@ Indeterminate )

Severity ID Entity Parameter Event Time Title Manager Tool ID Agent Environment Location Country

11-2-c-asd-nd34b46647...  entityS01 memory 2024/01/31 181400  memory issue solarwinds solarwinds Prod Noida India
11-2-c-asdnd34b46647...  entityS00 pu 2024/01/31 181300  cpuiissue solarwinds solarwinds Prod Noida India

11-2-c-asd-nd34b46647..  entity3 swap 2024/01/31 172200  swap issue solarwinds solarwinds

1-2-c-asd-nd34b46647...  entityl pu 2024/01/31 171400  cpuissue solarwinds solarwinds

2-c-asdnd34b46647...  dlient] memery 2024/01/31 153400  memery issue solarwinds sclarwinds

2-c-asd-nd34b46644...  entity601 pu 2024/01/31 140400  cpuissue solarwinds solarwinds Prod

11-2-c-asdnd34b46647...  entityS01 memory 2024/01/31 132200 memory issue solarwinds solarwinds Prod Noida India

gG0606G6GE

B27fe66e-d591-dbeB-BL..  IAUMAPIAUDOOT  'Virtual machine CPU usa..  2024/01/31 120118 comuvmwarevim25.Alar..  vRealize Operations (vR.. vRealize Operations (vR..

Figure 49 - Refresh All Events
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This option will enable user to stop/start live update of data being shown in grid. Please follow below steps

to enable/disable live events.

1. In the top navigation bar, click on Data View and click on All Events.

2. Users can see the Live All Events Data, and this will be updated reqularly, and automatically refresh

the grid.

This option will enable user to apply filters over currently opened view to see data of specific values. For

e.qg., to see list of critical events, user can set filters over severity columns of all events ‘data. Please follow

below steps to apply filters:

1. In the top navigation bar, click on Data View and click on All Events.

2. Click on the filter option present at right side of Live button as shown in figure.

Data View > All Events

Select View Allevents v

(an’y("e citical ) ("o major ) (o Minor ){ « warning ) ("e Clear )" Indeterminate )

Severity 1D Entity Parameter Event Time Title
11-2c-asdhnd34ba6EAT..  entity5OT memory 2024/01/31 181400 memory issue
11-2c-aschrd34b6BAT..  entitySO0 <pu 2024/01/31 181300 <puissue
11-2c-a5hnd34bAGBAT.,  entityd swap 2024/01/31 172200 swapissue
11-2-c-asdnd2AbABB4T..  entityl <pu 2024/01/31 171400 cpuisat
11-2-¢-asd-rd34basedT clientl memory 2024/01/31 15:3400  memory issue

11-2-¢-asd-rd34bas644. entity601 <pu 2024/01/31 14:0400  cpuissue
11-2-c-asd nd24b4SEAT..  entiyS0T memory 2024/01/31 132200 memory issue

Sl ooTiedse o591 dbed-Bi

1{0bed2c-del-42b4-86

518eEbf6-aal 8407786,

IAUWIAPIALDOT  wirtual machine CPU usa,
10123066 Storage

10122066 Storage

2024/01/31 12:0118

2024/01/31 115050

2024/01/31 115049

commwarexim25 Alar

(1.381.2.1.13.0=521018.

(12812101 20=521018...

Manager

solarwinds

solarwinds

solarwinds

salarainds

salarainds

salarainds

solarwinds

VReslize Operations (v
Generic SNIP - Event

Generic ShINP - Even

Tool ID

Agent

solarinds
salarwinds
salarwinds
salarainds
salarainds
salarainds

solarwinds

Realize Operations (v
Generic SNMP - Event

Generic SMVIP - Event

Environment

Prod

Frod

Prad

Prod

GE?

Location

Noids

Moids

Noida

Country
inclia

inclia

nefia

3. Afilter screen will come up which enables user to select field and corresponding operator along with

value to filter data.
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Data View > All Events

Select View  Allevents v - o B R

Fields Operator Value

Severity ~ LIKE v Critical

(e citical ) ("o wajor ("o minor )("+ warning ) (e clear ) (@ indeterminate )

D Entity Parameter Event Time Title Manager Tool ID  Agent Environment Location Country

»
i
g

11-2-c-asd-nd24b4664T,,  entityS01 memory 2024/01/31 181400 memory issue solarwinds solarwinds Prod Noida  India
m 11-2-c-asd-nd34b4664T..,  entity500 pu 2024/01/31 18:13:00  <puissue solarwinds selarwinds Prod Noida India
m 11-2-¢c-a3d-d34b4664T. entity3 SWap 2024/01/31 172200 swap issue S0l arwinds solarwinds

WD 11-2-casdndaabassar,,  entitt pu 2024/01/31 171400 cpuissue solarwings selarwinds

11-2-c-asd-nd34bds6dT.,  clientt memory. 2024/01/21 15:34:00  memory issue solanwinds solarwinds

m 11-2-c-asd-nei34b46644..,  entitys01 wpu 2024/01/31 140400  cpuissue solarwinds selarwinds Prod

Noida India

11-2-c-a3d-nd34b46647.. entity501 2024/01/31 13:22.00 _ emory issue 50l arwinds solarsings

Figure 51 - Filter Operation

4. Users can see the result of applied filter.

Data View > All Events

Select View Allevents v - S B8 R

| Applied Flters | Severity 15 Critical = @
(0 Cr\tical) (a Majur>< Minor) ( Walmng) (o Clear) (. Indelerrnlnale)
Severity ID Entity Parameter Event Time Title Manager Tool ID  Agent Environment Location Count
B 11 ocmsdndadbasssd..  enitysor pu 2024/01/21 140400 cpuissue solarwinds solarwinds Prod
B oo duiabeB e, IAUMAPALDODT “irtual machine CPU s, 2024/01/21 120118 comumuwarenim?s Alar..  vRealize Operations (v&.. vRealize Operalions .
BB s:sovoaz-biffrieetdl.  hupsimifi-envozdryicel.  heartoeat 2024/01/31 113901 Heartoeat from Mifi recel..,  [EM-Nif {EN-i
cfifScba-bifeT1ee-aa0..  httpsy/nifi-envO2 dryicel...  heartbeat 2024/01/21 113601 Heartoeat from Nifi recai..  [EM-Nifi {EN-Mifi
BB ooovieazbietie2. hipsdnif-envi2dryicel.  heartbeat 2024/01/31 113402 Heartoeat from Mifi recei,,  iEM-Mif FEM-P
63690d56-bHe-11ee-6..  hsyjnifi-envi2 dryicel.. heartbeat 2024/01/31 113301 Heartoeat from Nifi recei...  IEM-Nifi {EN-Nii
EEED iocbadabife-itee09.  hipsinifi-envi2 dryicel . heartheat 2024/01/31 113203 Heartbeat from Nifi recel,.,  IEM-Nif IEM-Ni
BB sococv1-5e23-40066,  inpreesi3dryicelabsco,. Hostmemeryusage on.  2024/07/31 112942 comamwerevim2SAlar..  vRealize Operations 6. vRealize Operations 6R...
B :orcbsonsomanta B IALVIAPIALDOOT “Virtusl machine CPU s, 2024/01/31 112741 comumusrexim2S Alar..  viealize Operations (v Redlize Operations (R

Figure 52 - Filter Operation

3.2.5 Noise Events View
Noise Events View includes a grid which contains all the noise events in a single grid.
Please follow below steps to view Noise Events data:
1. Inthe top navigation bar, click on Data View and click on Noise Events.

2. Noise Events data will be displayed for the customer to which user is part of.
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Data View > Noise Events

Select View Moise Events v 7 Live 8 B R

@ ( & Critical ) (. Major)( Minor\( Warning) (- CIeal)( . lndeverminate)

Severity [+ Entity Parameter Event Time Title Manager Tool ID Agent Environment Location Country
11-2-c-33d-nd3db4664747 env_prod memory 2024/01/311633:00 memary issue solarwinds solarwinds
11-2-c-asd-nd34b4664746 cliantt memory 2024/01/31 153400 memory issue solarwinds solarwinds
Majar 11-2-c-25d-nd3db4664748 gamma_entity memory 2024/01/31 153000 memary issue solarwinds solarwinds
[ Major | 11-2-c-23e-nd3dbA664TS0 desktop-jbl memory 2024/01/30 160000 memory issue solarwinds solarwinds
[ vz | 11-2-c-asd-nd34b4664749 Yiaomi memory 2024/01/30 155000 memary issue solarwinds solarwinds
11-2-c-a3d-nd3db4664T53 10121180 memory 2024/01/21 170000 memary issue solarwinds solarwinds
[ sior | 11-2-c-2sd-ndl3db4664752 DESKTOP-365 memory 2024/01/21 170000 memory issue solarwinds solarwinds
11-2-c-asd-nd3db4664751 25entity memory 2024/01/20 160000 memary issue solarwinds solarwinds
11-2-c-asd-nd34b4s6d 755 Zebronics memory 2024/01/15 15:00:00 memaryissue solarwinds solarwinds
[ Major 11-2-c-asd-nd34bassa 154 Intel core memery 2024/01/11 170000 memory issue solarwinds solarwinds

Figure 53 - Noise Events View

3.25.1 AddColumn

This option will enable user to add more columns in data grid to analyze it deeply. Please follow below
steps to add columns to data view.

1. Inthe top navigation bar, click on Data View and click on Noise Events.

2. Click on the Add Column action button present at right side of Live button.

3. A pop-up will open which enables user to select from list of available columns to add it in the grid as

shown in figure. Then, click on save button to add selected columns in view.

Add Columns X

Add More Columns

Sub Entity ID v

Original Columns

O Severity X D ID X O Entity X Tile X Manager X J Primary Application Name X T Tool ID X
C Secondary Application Name X O Agent X O EventTime X O Mapped Entity D X O Parameter Category X

~ ~ ~

Z Parameter X [ Llocation X [ Environment ¥ [ Designation X

Newly Added Columns

2 Sub Entity ID %

Figure 54 - Add Column

3.2.5.2 Save As Noise Events

This option will enable user to save currently opened view with columns populated in data grid so that

same view can be shown to any other user in an organization. It is very helpful for admins to configure this
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kind of view for other users in an organization by creating a different view other than current view. For e.qg,,
view to list out noise events with critical severity only. Please follow below steps to save as events:
1. Inthe top navigation bar, click on Data View and click on Noise Events.
2. Once the user can click the save as button, a pop-up will open to provide following information:
e View Name: name of view like critical noise events
e Description: description of view like list all critical noise events

e Show to: Either it will be visible to user who is saving it or to other users.

Save As X

View Name Description

Figure 55 - Save as Events

3. Next, click on save button to save view and this view will be available in list for users.

3.2.5.3 Refresh Noise Events

This option will enable user to refresh data grid to populate latest data over screen.
Please follow below steps to refresh noise events grid:
1. Inthe top navigation bar, click on Data View and click on Noise Events.

2. Once the user can click the Refresh button, confirmation pop up message will appear.

Data View > Noise Events

Select View Noise Events ~ Io Content refreshed successtully % < live a 8 R

2]

(Can ) (e critical )("e major ) ("o Minor ) ("s waming ) ("e clear ) (e Iindeterminate )

Severity [+ Entity Parameter Event Time Title Manager Tool ID Agent Environment Location Country
m 11-2-c-asd-nd34b4664747 env_prod memory 2024/01/31 16:33:00 memoryissue solarwinds solarwinds

m 11-2-c-asd-nd34bd664746 client1 memory 2024/01/31 15:34:00 memory issue solarwinds solarwinds

[ Mo | 11-2-c-a3d-nd34b4664748 gamma_entity memory 2024/01/31 15:30:00 memoryissue solarwinds solarwinds

[ Maier | 11-2-c-a5d-nd34b4664T50 desktop-jol memory 2024/01/30 16:00:00 memory issue solarwinds solarwinds

m 11-2-c-asd-nd34b4664749 Kisomi memory 2024/01/30 15:50:00 memory issue solarwinds solarwinds

m 11-2-c-asd-nd34b4664753 10121160 memory 2024/01/21 17:00:00 memory issue solarwinds solarwinds

m 11-2-c-asd-nd34bd4664752 DESKTOP-365 memory 2024/01/21 17:00:00 memory issue solarwinds solarwinds

m 11-2-c-asd-nd34b4664751 25entity memory 2024/01/20 16:00:00 memory issue solarwinds solarwinds

Figure 56 - Refresh Noise Events
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3.2.5.4 Live Noise Events Data

This option will enable user to stop/start live update of data being shown in grid. Please follow below steps

to enable/disable live noise events.

1.

2.

3. To stop live data update, please click on Live button, it stops updating the live noise event data, a

In the top navigation bar, click on Data View and click on Noise Events.
Users can see the Live Noise Events Data, and this will be updated reqgularly, and automatically

refresh the grid.

Data View > Noise Events

Select View Noise Events v EG 8 R

( ( it ( i i ) ing ) ) i 1
(an)( e cmuca\) (e Majorj( minor ) ("o waming ) ("e Clea|/<. Indeterminate )

H
3
z

D Entity Parameter Event Time Title Manager Tool ID Agent Environment Location Country

= 11-2-c-asd-nd3abaEEATAT env._prod memary 2024/01/31 163300 memary issue solarwinds solarwinds
m 11-2-c-a3d-nd34b4664746 dlient? memary 2024/01/31 153400 memory issue solarwinds solarwinds
2z 11-2-c-25d-nd34b466474B gamma_entity memary 2024/01/31 15:30:00 memary issue salarwinds solarwinds
= 11-2-c-asdnd34b4664750 desktop-jbl memory 2024/01/30 16:00:00 memery issue solarwinds solarwinds
= 11-2-c-a5d-nd34baBEATAS Xiaomi memary 2024/01/30 155000 memory issue salarwinds solarwinds
m 11-2-c-a3d-nd34bd6e4 753 10121160 memary 2024/01/21 17,0000 memory issue solarwinds solarwinds
m 11-2-c-a5d-nd34bd664752 DESKTOP-365 memary 2024/01/21 17,0000 memory issue solarwinds solarwinds
= 11-2-c-a3d-nd34b4664751 2sentity memory 2024/01/20 18,0000 memory issue solarwinds solarwinds

Figure 57 - Live Events Data

confirmation message will appear, stating that "Auto - refresh has been disabled.”

3.25.5 Apply Filters

This option will enable user to apply filters over currently opened view to see data of specific values. For

e.qg., to see list of critical noise events, user can set filters over severity columns of noise events data. Please

follow below steps to apply filters:

1.

2.

In the top navigation bar, click on Data View and click on Noise Events.

Click on the filter option present at right side of Live button as shown in figure.

Data View > Noise Events

Select View Noise Events ~ 2 Live a B8 ’

(E)(. Crili(alr/\l(:o Majm')(_ Minor) \ Wamlng;){ . clearl)(_o Indeterminate )

Severity o Entity Parameter Event Time Title Manager Tool ID Agent Environment Location Country
11-2-c-asd-nd34b4664747 env_prod memory 2024/01/31 1633:00 memory issue solarwinds solarwinds
[ Mapr | 11-2-¢-a3d-nd34b4664 748 dientt memory 2024/01/31 15:34100 memory issug solarwinds solarwinds
[ Mar | 11-2-¢-850-nd34b4664748 gamma_entity memory 2024/01/31 153000 memory issue solarwinds solsrwinds
11-2-¢-350-nd34b4664T50 dasktop-jbl memory 2024/01/30 160000 memory issue solarwinds solarwinds
[ Major | 11-2-¢-850-nd34b4664 749 isomi memory 2024/01/30 155000 memory issue solarwinds solarwinds
[ Major | 11-2-¢-85d-nd34bAGE4TS2 101.21.160 memory 2024/01/21 170000 memory issug solarwinds solarwinds
[ Maor | 11-2-¢-880-nd34bA664752 DESKTOP-365 memory 2024/01/21 170000 memory issus solarwinds solarwinds
[ Major | 11-2-¢-850-nd34b4664751 25enity memaory 2024/01/20 1600100 memory issue solarwinds solarwinds

Figure 58 - Filter Operation
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3. Afilter screen will come up which enables user to select field and corresponding operator along with

value to filter data.

3.3 Customer

The goal of customer onboarding in Event Management AlOps is to facilitate efficient introduction to the
platform, ensuring that customers can quickly and effectively utilize the features of the system for

managing events with the support of Al-driven capabilities.

3.3.1 Edit Customer
HCL IEM allows the user to edit the customer details with this option. When the user clicks on Edit
Customer, the navigation panel will show the options that can be accessed by the user.
It includes: -
e Customer Details
¢ Noise Maintenance

1. Click on the edit icon corresponding to the name of the customer whose details are to be updated.

The following screen appears:

HCL IntelliOps
S Event Management

Choose File | No file chasen

Figure 59 - Edit Customer

3.3.2 View Customer

1. To view the details of a customer, click on the view icon corresponding to the name of the customer

whose details are to be viewed. Refer the following image:
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3.33

Customers

Customer Description Onboarding Steps m

dryiceiem em Operations ® 2 + L

Figure 60 - View Customer

Noise Maintenance
Noise maintenance” refers to the ongoing process of managing and reducing the amount of irrelevant or
non-actionable events, alerts, or data generated by the monitoring and detection systems. Noise, in this
context, represents information that does not contribute to meaningful insights or indicate significant
issues. Reducing noise is crucial for optimizing the efficiency of actionable detection, analysis, and

resolution.

"Noise Maintenance Window" refers to a specific timeframe or scheduled period during which fine-tuning
activities are performed to manage and reduce the noise generated by the monitoring and alerting
systems.

This window allows IT teams to proactively address the issues related to false positives, irrelevant alerts, or
unnecessary noise in the event data.

This section enables user to define rules for filtering out events data at the beginning of event data
processing. User can perform actions based on their role.

Admin can see all the previously created noise rules by clicking on customer edit action button >

Noise/Maintenance Window.

Customer > dryiceiem > Noise Maintenance

§% Customer Details Noise Maintenance + 1w || |
[ 550 Configuration O Ruls Name Modifisc On Actions

8¢ Role maintenace on iautol_db 2024-02-08T0825.32 2 m

@ Ussr O Moise Entity izutol_ob 2024-02-08T08:05:35 2 m

28 Group Show 10 ¥  entries n
@ Integrations

P Correlation Rules

B Entity

&8 Topclogy

“g Servios Hisrarchy

82 Noise Maintenance

Figure 61 - Noise Maintenance

A user can perform the following actions:
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e Add Noise

e Edit Noise

e Delete Noise

e Apply Filters
Rules can be created from the Entity screen. Please refer to the /EM Configuration Guide > Entity
section. These rules are prefixed with the action i.e., whether it is a Noise, or a Maintenance

configuration followed with the Entity name. From the screen user can create rule-based entity id
only.

Noise rules can be configured as required, by following the steps given below:

1. Click on + New button at the top of the grid to create a new rule. The following screen appears:

Noise Maintenance
Rule Name

Noise Entity iauto1-db

Base Filters
Entity IS jauto-iscript X

+ Add

Define Maintenance

Recurring Daily >

Start Date Start Time End Date End Time

12/27/2022 12:00 AM ®© 12/27/2022 12:00 AM ®©

Figure 62 - Creating Noise Rule
2. Enter the Rule Name.
3. Inthe base filters field, select the Entity, then select operator then give value. Users can add many
base filters by clicking on +Add button.
4. User can define maintenance window and Recurring.

Add the required fields then click on the submit action button.

Edit the rules based on requirement, base filters can be added, or maintenance window can be modified

(change the time interval or dates interval etc.)

Rule name cannot be edited.
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Noise Maintenance
Rule Name

Noise Entity iauto1-db

Base Filters

Entity IS iauto-iscript X

+ Add

Define Maintenance

Recurring Daily ¥
Start Date Start Time End Date End Time
12/27/2022 12:00 AM @ 12/27/2022 06:00 PM @

Figure 63 - Updating Noise Rule

3.3.3.3 Delete Noise

1. User can delete noise rules using delete action button.
2. Select the rule(s) to be deleted by clicking on the corresponding checkbox.

3. Click on the delete action button (bulk/single selection).

Noise Maintenance

O Rule Name Modified On Actions
maintenace on iautol-knoweldge 2022-12-26T10:19:23 w £
Noise Entity iauto1-db 2022-12-26T10:18:51 W &

Show 10 ~  enlries

Figure 64 — Bulk Delete Noise Rule

4. The following popup will appear.
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Delete Noise Rule X

Are you sure you want to delete the noise rule? It cannot be
undone.

Figure 65 — Confirmation Pop-up

5. Click on Confirm. Noise rules will be deleted.

1. Click on the Apply filter action button present at the below header of the console.
2. The form will appear from where the user can select field and operator from the drop-down list and

provide value. Then click on the apply button.

Customer > dryiceiem > Noise Maintenance

&7 Customer Details Noise Maintenance + new | [

[ $50 Configuration AppliedFilters | Rule Name LIKE noise * 7

o Rule Name Modified On Actions
A Role

noise-entity-3 2024-02-03T07:09:39 o
@ User

Y £

O MNoise-Entity-2 2024-02-08T07:08:17 ™

Ag Group
Show 10 ~  entries n
€3 Integrations
B Correlation Rules
B Entity
€ Topology

°le Servics Hisrarchy

88 Noise Maintenance

Figure 66 - Noise Maintenance - Apply Filter

A health check module is a crucial component of HCL IEM alongside which enables admin to monitor the
status and performance of deployments, such as NiFi endpoints, and integrations at HCL IEM-IMM'’s end.
With this module, admin can reqularly assess the health of these components, ensuring they are
functioning optimally and identifying any potential issues before they escalate. By providing real-time
insights into the health of deployments and integrations, the module empowers admin to take proactive
measures to maintain system reliability and prevent disruptions.
Through this module, user can manage Health check for Deployments (NiFi endpoints) and Integrations
(adapters) through below steps:

1. On the Main Menu bar, click Health Check.
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2. The Health Check screen appears, and it lists down the available Deployments and Integrations.

HCL DRYIiCE @ =1 i @
IMM Home Secrets Deployment

Home > Health Check

Process Type
~Select v
Dep010224 NiFi
Last 24 Hours Performance
@ 2 Availability Issues 0
® Performance lssues 1679
Deployed
© Access Issues 0
View All
QADeployment NiFi
Last 24 Hours Performance
@ © Availability Issues 0
2 Performance lssues 0
Deployed
©) Access Issues o

Integration

% ®

Event Room Job

Health Check

19122023 wii

Last 24 Hours Performance

@ @ Avallability Issues

(@ Performance Issues
Deployed

© Access lssues

d-19-dec-002 NiFi

Last 24 Hours Performance

@ © Availability Issues

(@ Performance lssues
Deployed

© Access Issues

0

0

0

View All

admin@imm.com v

QADeploymentNew Nifi
Last 24 Hours Performance
@ 2 Availability Issues. o
5 Performance Issues 0
Deployed
© Access Issues 0
View All
d-19-dec-001 niri
Last 24 Hours Performance
@ 2 Availabiliy Issues 0
@ Performance lssues 0
Deployed
©) Access Issues 0

Figure 67 - Health Check

3. Using Process Type dropdown, user can filter the tile accordingly.

HCL DRYICE @ 3 33
MM Home Secrets Deployment

Home > Health Check

Process Type
--Select-- -
Q

Deployment

Integration

Integration

L) ]

Event Room Job

19122023 niFi

Last 24 Hours Performance

@ Awailability Issues

Figure 68 — Process Type

admin@imm.com ¥

QADeploymentNew nifi

Last 24 Hours Performance

(@) Availability Issues

4. Eachtiles categorized the issues
e Availability
e Performance

e Access

5. To View detailed logging click on View All link on each tile. It will provide the details of

corresponding to each category.
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Note: **All dates are in mm/dd/yyyy hh:mm format

Dep010224

Status Time (UTC)

NiFi URL re:

All the nod:

Figure 69 - Logs (KPI Details)

Refer the below table to understand the fields mentioned in the above figure.

Table 12 - View Health Check Logs field

Fields Description

KPI Displays the KPI Name.

Status Displays the Status Success or Fail.
Description Displays the Description.

Status Time Display the Status Time.

The Event Room serves as a dedicated space alongside the HCL IEM where administrators can monitor
events that have not been successfully transmitted by NiFi to HCL IEM. This module provides visibility into
the events that are currently queued or pending transmission, allowing administrators to identify any issues
or bottlenecks in the data transfer process.

By displaying queued events in the Event Room, administrators can quickly assess the status of data
transmission and take appropriate actions to address any issues. This might include investigating the root

cause of transmission failures, resolving connectivity issues, or optimizing data transfer configurations.

Through this module, user can view the events data which NiFi is not able to send to IEM portal. The events
data is categories into four categories (Event, Metrics, Service, Entity).
Kindly follow the below steps to access Event Room:

1. Onthe Main Menu, click Event Room. The Event Room screen appears.

IEM User Guide 52



HCL DRYiCE @ 2 ki ] =
MM Home Secrets Deployment Integration Health Check

Iob admin@imm.com v

Home > Event Room

a | Nota: **All dates are in mm/dd/yyyy hh:mm format

Figure 70 - Event Room Type

2. Select the appropriate category from the Type dropdown. The following options available:

e Entity
e Event
e Metrics
e Service

3. On selecting the type, the grid will be populated with the events data pushed by NiFiin IMM DB.
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4 Support

To get support for this product, please drop an email to IMM-Product-Supp@hcl.com.
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